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Introduction 
NorthClark’s Part Number Search Query may be used to locate Part Numbers in your Manfact system 
using a variety of search criteria.   

Environment 
The main screen is composed of eight “tabs”.  The Search and Results tab are the two tabs that will be 
utilized in locating a part number.  The remaining tabs display information that is contained in the 
Manfact PARTS and Inventory files, organized by departments:  Engineering, Planning, Material, 
Purchasing, Marketing and On Hand.   

 

Part Number Search Query 
Locating a Part Number (Search Tab) 
If you know the Part Number that you want to inquire on, you can simply enter it and press the Enter 
key, and you will be immediately directed to the Engineering tab.  If you don’t know the specific part 
number, but know some basic information about the item, several fields are available to use in 
narrowing your search.   

 

The fields you may use in your search include: Part Number, Description, Vendor Description, 
Mfg#*Part#, Notes, Vendor #, Product Class, Sub-Class, Part Type, Category, Buyer, Planner, and 
Make/Buy Code. You can even List the Location Contents of a specific stock inventory location and if 
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you use bin locations, the bin location detail will be displayed.  In addition you may exclude parts that 
have been flagged for deletion. 

Note, when searching on Part Description, eliminate all characters that are not letters or numbers 
(spaces, dashes, slashes, etc.).  This should increase the probability of finding a match, and reduce the 
likelihood of creating duplicate part numbers. 

If you don’t know the specific details of a particular field, you might use wildcarding to enter only a 
portion of the item’s part number, description, etc.   

To further assist you in locating the desired part number, you may Sort the search results by either the 
Manfact Part Number or the Engineering Description. 

After you have entered all of the desired search fields, click the [Search] button. 

Search Results 
After you choose the [Search] command, the results are displayed on Tab 2 “Results”. One part number 
and its associated description are displayed on each row of the list.  

There are two ways you can select an item from the list: 

 Position the highlight bar over the desired part number using the arrow keys, or by clicking 
anywhere on the row with mouse, then click the [Select] button at the bottom of the screen. 

 Double-click on the desired row using the left mouse button. 
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Note: if your search resulted in only one part number, the Parts information will be shown 
automatically, so there is no need to select anything. 

Engineering 
This view displays Engineering and other descriptive information about the Part. 

 

Below are descriptions of the fields displayed on the Engineering view. 

Part Number The selected part number. 

Description The name or a brief description of the item. 

XPL Code The explode code assigned to the part number you selected: 

 X = Assembly (Explode) 

 XP = Phantom Assembly (Blow Through) 

 Blank = Component (no bill of material) 

 L = Line Stock 

Issue U/M The unit of measure by which each part will be issued or stocked. 

Hold Code The hold code assigned to the part you selected 
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D = Discontinued, no orders recommended. 

U = Use up remaining stock. 

O = Obsolete, do not issue to work order. 

Owner Plant The Plant that has ownership or primary control of the part. 

Part Type User defined code that can be used as selection criteria for the mass 
change procedure. 

Valid codes can be defined in the Code Administration procedure. 

Category User defined code that can be used to help group items for reporting 
purposes. 

Valid codes can be defined in the Code Administration procedure. 

Rev. Level Revision Level of the item. 

Rev. Date Revision Date of the item. 

Notes Notes that have been entered for the item. 

Explode One Level “Yes” indicates to Explode one level when creating a work order. 

Purchased Assembly “Yes” indicates the assembly is to be configured as a “buy” part for 
costing purposes. 

Delete Flag “Yes” indicates the part is flagged for deletion. 

Custom Fields   Custom fields are defined using NorthClark’s Bill of Material Setup 
procedure. 

Made From Parts for outside processing not performed on a work order material. 

Part Number         The part number that is supplied 

Quantity                The quantity that is supplied 

Equivalents A listing of part numbers which may be used as equivalents 

Part Number         The equivalent part number. 

Quantity                The quantity required of the equivalent part. 
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Planning 
This view includes Master Scheduling and Material Requirements Planning parameters.  

 

Planning Parameters: 

Make/Buy Defines whether MRP will explode requirements.  MRP will not explode 
buy items. 

Plan Fence A period of time, in days, when it is unfeasible to alter the master 
schedule or WO’s. 

Demand Fence A period of time, in days, when the sales forecast is consumed entirely by 
backlog. 

Routing Routing Identifier (BOO File). 

Planner Code Code used to indicate who is responsible for planning this part. 

Forecast Type Sales Forecasting Type Code (S)pare or (F)inished Goods 
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Order Policy Order Policy Code for the part used for MPS/MRP processing 

D = Discrete (actual need) 

F = Fixed (minimum quantity over need) 

L = Least Total Cost 

P = Part Period Balancing 

T = Time Phased (need + need for ‘x’ days) 

Days Supply The number of days that the Order Qty must cover requirements. 

Order Qty The minimum Order Quantity of each item. 

Order Multiple Order quantities will be suggested in multiples of this quantity. 

Yield% Standard yield or shrinkage factor. 

MPS? “Yes” indicates that the item is processed by MPS. 

MRP? “Yes” indicates that the item is processed by MRP. 

Detailed Pegging “Yes” indicates that MRP will maintain detailed pegging for the item. 

Auto Release “Yes” allows the Planner System to automatically launch live orders. 

Buy Guide “Yes” indicates that the part will be reported on the buying guide. 

Lead Time 

Planning Number of days required to plan the part. 

Assembly / Buy Number of days required to assemble or purchase the part. 

Total Lead Time Total lead-time for the part. 

Cumulative Calculated by adding the longest Total Lead-Time at each level of the 
structure. 

Part Period Balancing 

Cost Group Cost Group used to determine the unit cost for Part Period Balancing. 

2nd Policy Secondary PPB Policy Code (D)iscrete, (F)ixed, or (P)art Period 
Balancing. 
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Days Plan Number of days after which to switch to PPB 2nd Policy. 

Place $ Dollar amount of Order Placement Cost. 

Setup $ The dollar cost per order to set up for production. 

Carrying $ Cost per unit per day held in inventory. 

Place % Percentage of overall unit cost for Order Placement. 

Setup % Percentage of overall unit cost for Setup. 

Carrying % Percentage of overall unit cost for holding the item in inventory. 

 

Material 
This view displays material control information. 
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Material Control Fields: 

QA Inspection 
Required 

Defines whether the QA System will be used for this part. 

QA Report 
Required 

“Y” indicates that QA reports will be printed for this part 

Serial Controlled “Y” indicates that transactions for the part will require serial numbers. 

Lot Controlled “Y” indicates that transactions for the part will require lot numbers 

Fractional Qty’s 
OK 

"Y" indicates that this part may be stocked or used with a fractional 
quantity 

Stockable Phantom “Y” indicates that this phantom assembly may be stocked. 

Auto WO Close “Y” indicates work orders for this item will automatically close at month 
end. 

Freeze ABC “Y” indicates the ABC code will not be updated by stratification 
(PARTS05) 

QA Spec Code The specification code from the QA.SPEC File for this part. 

Safety Stock The minimum quantity that should always be maintained in stock. 

Max Inventory If Min-Max planning is used; this is the maximum inventory level. 

Shelf Life The number of days the item may remain in inventory before expiration. 

ABC Code Alphabetic category for cycle counting frequency of this item. 
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Purchasing 
This view displays Purchasing parameters for the part. 

 

General Purchasing Information 

Buyer Code The individual normally responsible for buying this item. 

Tax Type User defined default code to define whether the item is taxable or not. 

Load Factor Factor for distributing estimated freight costs. 

Price Conv Conversion Factor used when Unit Price is not equal to Buy Unit of 
Measure. 

Forecast Part If “Y”, the part will be included in the Vendor Forecast Report. 

Fcst PO/SPO If the part is a Forecast Part the code specifies which planned order time 
period is used. 

Supplier Information 
In addition to manual entry, supplier information is updated automatically by activity that occurs when 
creating or updating a Purchase Order, PO Receipt or an Accounts Payable invoice.  All suppliers that 
have been entered or have had activity will appear on the list. 
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Vendor Number Ship from vendor number. 

Vendor Name Supplier name 

Vendor Description Supplier’s description of the part. 

Order Multiple The number of units the vendor usually packages together. 

Buy U/M Purchase unit of measure and factor needed to convert to stocking unit 
of measure. 

Buy U/M Factor Factor required to convert the Buy U/M to the Stocking U/M. 

Vendor Cost Last cost paid to the vendor. 

Price Per Number of units included in prices quoted for this part and vendor. 

Unit Freight Estimated freight cost per vendor unit. 

Last Cost*Source Source transaction of the last cost information.  Information displayed is 
the transaction date, transaction ID number, and type of transaction (PO, 
RC, AP) 

Mfg. Name and Part # A list of manufacturers name and associated part numbers that may be 
supplied by the vendor. 

Plant Code The PLANT code associated with this part. 

Composite Rating This is the composite vendor performance rating for this part and this 
vendor. 

 

Approved Manufacturer Fields 
If Approved Manufacturer features are utilized, a listing of the approved manufacturer ID, manufacturer 
part number, manufacturer name and notes will be displayed. 
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Marketing 
This view displays Sales and Marketing parameters. 

 

Marketing Fields: 

Product Class User defined Product Classification assigned to the part. 

Sub Class User defined Product Sub-Classification assigned to the part. 

Mrk Tax Type Tax Type Code to define the billing taxable or non-taxable default for 
the part. 

Price Per Factor Default for SOE to express the price of this part per a specified number 
of units 

Units Per Pkg Number of units of this part normally shipped in a single package. 

Unit Weight Weight per part for the standard unit of measure. 

Clip Qty Used by the Buying Guide and Sales Forecasting to lower abnormally 
high demand. 

Non Inv Cost*Per Unit cost for this item on non-inventory shipments. 

11 



NorthClark Computing, Inc.  

NSN Number U.S. Department of Defense, National Stock Number assigned to the 
part. 

NSN Description Description assigned by the U.S. Government to this NSN part number. 

Ref Part Number An internal alternate part number that has been assigned to this item. 

Complementary Parts 
and Parts List 

Complementary Parts and Parts List assigned to this item and used 
during SOE. 

Substitute Parts and 
Parts List 

Substitute Parts and Parts List assigned to this item and used during 
SOE. 

Customer Shipping Requirement Information 
If you have entered specific Customer shipping requirement information for the part, the information 
will be displayed as follows.  This information includes the Customer number, Customer’s Part #, the 
Packaging Quantity, whether the item is a JIT part for EDI purposes, and which days are authorized ship 
days. 
 

On Hand 
The quantities displayed include all stocking locations chosen using the Inventory Locations option 
found on the View Menu. 
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On-Hand Inventory Information: 

Last Supplier The vendor number and name associated with the most recent PO 
Receipt. 

Supplier Part# The vendor’s part number, associated with the last supplier. 

Buy U/M The unit of measure that is used when purchasing the part. 

Stock U/M The unit of measure that is used for stocking the part in inventory. 

Supplier Cost The last unit cost paid to the supplier for this part. 

Average Cost This is an average cost based on information contained in the 
COSTHIST file. 

Last Cost The last actual P.O. or work order cost. 

Selling Price The generic selling price that has been defined in the PRICE file. 

Inventory Status Information 

Stock U/M The standard issue unit of measure that is used to stock and transact the 
item. 

On Hand Quantity on hand in the physical stock locations specified. 

Available On Hand Qty less Allocated and Reserved Qty (optionally less 
Backorder Qty). 

On Order Quantity of the part due to be received on a PO or released WO. 

In Transit Quantity that has been shipped on a transfer requisition and not yet 
received. 

Requested Quantity requested on a purchase requisition, unreleased WO or 
transfer req. 

Allocated Quantity currently allocated to sales orders or transfer requisitions. 

Reserved Quantity currently reserved for sales orders and work orders. 

Backorder Quantity backordered for sales orders and work orders. 

Future Quantity on sales orders or work orders with a future schedule date. 
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Bin Location Information 
If you utilize bin locations, the bin location details will be displayed for the physical locations that are 
designated as Multi-Bin “Y” in your Inventory Location file.  Detail for locations that are not designated 
as Multi-Bin will not be displayed. 

The information that will be displayed is the physical Inventory Stocking Location, the Bin Location 
within that Stocking Location, the Lot Number (as applicable) and the associated On Hand Quantity. 

Selecting Inventory Locations 
Select the Inventory Locations option from the View menu to modify the list of locations to be used in 
the calculation of On-hand and Available Inventory. 
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General Information 
Main Menu Options 
The following options are available from the Main Menu of the Part Number Search Query. 

Menu Option Description 

File Login Logs user into the procedure. 

File Clear Clear all current data on all displays. 

File Print Print the current active spreadsheet.   

File Export Export data from the active spreadsheet.   

File Exit Close the application 

Edit Copy Copy data to the Windows clipboard.   

Edit Zoom View, print and/or edit the expanded contents of a field.   

View Unhide All Columns Expose all columns previously hidden. 

 

View Auto Fit Columns Automatically adjust the width of each column to 
accommodate your data.  

View User Preferences Set user preferences affecting the contents and appearance of 
the screen. 

View Inventory Locations Select Inventory Locations. 

 

Right Click Menu 

Copy Copy data to the Windows clipboard.   

Cut Cut data from the field and copy it to the Windows clipboard.   

Paste Paste data from the Windows clipboard. 

Fill Update all of the selected cells from the Windows clipboard. 

Zoom View, print and/or edit the expanded contents of a field 
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Printing a Spreadsheet 
This option will print the current active spreadsheet, so be sure to click on the spreadsheet you wish to 
print before choosing the Print option. 

 

Range - Selecting a Print Range:  You may choose to print the entire spreadsheet (all), selected cells 
(those that you have highlighted on the current screen), the current page (only the rows that are currently 
visible on your screen), or a range of page numbers.  

Orientation - Portrait or Landscape:  You may print your report in portrait mode (normal) or landscape 
mode (sideways). Printing in landscape mode will allow you to fit more columns of information on your 
report.  

Margins - Report Margins:  You can make your report more attractive by setting the top, bottom, left, 
and right margins. Reduce the left and right margins if you need to fit more columns on the report.  

Units - Inches or Centimeters?  Are the margins you entered expressed in inches or centimeters?  

Page Order:  If your report is too wide, it may span multiple pages. When this occurs, do you want the 
report printed from top to bottom or left to right?  

What Do You Want to Print?  You can customize the appearance of your report by printing (or not 
printing) column headers, row headers, grid lines, borders, shadow, and color.  
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Headers and Footers: Your report may have up to three lines for the heading, and one line for the 
footer. The system initially displays a default heading, which you may modify if desired.  Tip: Use /p to 
designate a page number.  

Which Columns Do You Want to Print?  The columns that are available for printing are listed. Select 
the columns you wish to include on your report.  

 

Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 

 

Save As File Name:  Enter the pathname of the file you wish to create.  You may Browse the files by 
clicking the button to locate the drive and folder where the file will be stored. 

Sheet Name:  Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export Button:  After all required information has been entered, click this button to export your data to 
Microsoft Excel. 
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Editing Features 

Copy, Cut, Paste and Fill 

You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  

To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  

To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 

If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 

 Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking the 
magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

• The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the field 
when it is allowed.   Click "OK" when finished, or "Cancel" to revert to the original data.  

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 
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Customizing Your Display / Arranging Columns 
Use the User Preferences screen to make the following changes:  

 Each tab contains a list of fields that corresponds to a screens used in this application.  Use the 
checkboxes to show or hide each field.  

 Use the [Move Up] and [Move Down] Buttons to re-arrange the order in which the fields appear 
on the specific screen Display. Click [Reset All] to return to the system’s default settings. 

 You may opt for the system to “Remember Screen Size and Column Widths”. Any changes you 
make to the screen's appearance will be saved and applied the next time you launch this 
application.  

 Click [OK] to apply any changes you have made or [Cancel] to revert to the previous settings. 

. 
 
Note, these settings are stored in the Windows Registry for each user. 
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Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry.  You can also use “+” and “,” to include and/or conditions.  Here are some 
examples of search commands and their expected results: 

…MOTOR… or *MOTOR*  Search for the word “Motor” anywhere in the field 

*MOTOR*+*FAN* Both “Motor” and “Fan” must appear in the field 

*MOTOR*,*FAN* Either “Motor” or “Fan” must appear in the field 

 
 

Security 
Access to NorthClark applications is governed by the Manfact security system.  The System 
Administrator must add the appropriate commands to each user’s security table.  Please refer to the 
Manfact documentation for more information on setting up security tables. 

The following NorthClark procedures may be added to the Manfact security tables: 

Routine Description 

NCC_PARTSQ Allows access to all views within the Part Number Search Query. 

NCC_PARTSQ_STK User is limited to the Search, Results, and On-hand views. 
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